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WARRANTY 
 

 
Doremi's warranty obligations are limited to the terms set forth below: 
 
Doremi Labs, Inc. ("Doremi") warrants this hardware product against defects in materials and workmanship for a period of ONE (1) 
YEAR from the date of original retail purchase. 
 
If you discover a defect, Doremi will, at its option, repair, replace, or refund the purchase price of this product at no charge to you, 
provided you return it during the warranty period, with transportation charges prepaid, to your nearest Doremi Labs repair facility. To 
each product returned for warranty service, please attach your name, address, telephone number, and a copy of the bill of sale 
bearing the appropriate Doremi serial numbers as proof of date of the original retail purchase. You will also need to contact Doremi 
Labs technical support to receive a return authorization number (RMA). 
 
This warranty applies only to hardware products manufactured by or for Doremi that can be identified by the "Doremi Labs" 
trademark, trade name, or logo affixed on them. Doremi software is warranted pursuant to a separate written statement packed with 
the software. Doremi does not warrant any products that are not Doremi products. This warranty does not apply if the product has 
been damaged by accident, abuse, misuse, or misapplication; if the product has been modified without the written permission of 
Doremi; or if any Doremi serial number has been removed or defaced. 
 
THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, WHETHER ORAL 
OR WRITTEN, EXPRESS OR IMPLIED. DOREMI SPECIFICALLY DISCLAIMS ANY AND ALL IMPLIED WARRANTIES, 
INCLUDING, WITHOUT LIMITATION, WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
No Doremi distributor, agent, or employee is authorized to make any modification, extension, or addition to this warranty.  
 
DOREMI IS NOT RESPONSIBLE FOR SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY 
BREACH OF WARRANTY, OR UNDER ANY OTHER LEGAL THEORY, INCLUDING BUT NOT LIMITED TO LOST PROFITS, 
DOWNTIME, GOODWILL, DAMAGE TO OR REPLACEMENT OF EQUIPMENT AND PROPERTY, AND ANY COSTS OF 
RECOVERING, REPROGRAMMING, OR REPRODUCING ANY PROGRAM OR DATA STORED IN OR USED WITH DOREMI 
PRODUCTS. 
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Software License Agreement 
 

THIS SOFTWARE LICENSE AGREEMENT is provided by Doremi Labs, Inc. ("Licensor"). PLEASE READ ITS TERMS CAREFULLY, AS 
YOUR USE OF THE SOFTWARE WILL CONSTITUTE YOUR ACCEPTANCE OF THE TERMS OF THIS AGREEMENT.  
 
1. License. Licensor grants to the customer a non-transferable and non-exclusive license to use the software and 
associated documentation being provided with the Doremi Labs equipment being acquired by the Customer (respectively, the "Software" and the 
"Documentation"). Title in, ownership of, and all right associated with the Software shall remain vested in the Licensor. THE CUSTOMER 
SHALL HAVE NO RIGHT TO MODIFY, DE-COMPILE, REVERSE ENGINEER OR TRANSLATE THE SOFTWARE OR THE 
DOCUMENTATION OR DISTRIBUTE COPIES THEREOF TO ANY OTHER PERSON OR ENTITY. Licensor reserves all rights not 
expressly granted to you. 
 
2. Confidentiality of the Software. The Customer acknowledges and agrees that the Software and the Documentation constitute valuable 
proprietary products and trade secrets of the Licensor embodying substantial creative efforts and confidential information, ideas and expressions. 
The Customer agrees to maintain in all respects the confidentiality of the Software including, without limitation, agreeing not to disclose or 
otherwise make available to any other person or entity, in any manner, the Software in any form whatsoever, except that such disclosure or 
availability shall be permitted to an employee of the Customer whose duties and responsibilities require access to the Software in the course of 
his or her employment or to agents or independent contractors of the Customer performing maintenance or support services requiring access to 
the Software. The Customer further agrees not to alter or remove any copyright or other proprietary rights notice or identification which indicates 
the Licensor's ownership from any part of the Software. 
 
3. License Non-Transferable. Neither the license granted by this Agreement nor any copies of the software, the 
documentation, or any other materials delivered by the Licensor to the Customer pursuant to this Agreement may, in whole or in part, be 
assigned, sublicensed, loaned out, distributed, or otherwise transferred by the Customer to any other person or entity without the prior written 
consent of the Licensor. Any attempt to so assign, sublicense, loan, distribute or otherwise transfer such materials shall be deemed null and void. 
If the Customer desires to transfer the license in connection with a sale of the Doremi Labs equipment being purchased by another Customer, the 
Licensor hereby consents to the assignment of the license provided (a) such sale otherwise complies with the terms of this agreement and 
applicable law and (b) the transferee reads and agrees to accept the terms and conditions of the agreement. 
 
4. Export by Law Assurances. The Customer agrees and certifies that neither the Software and documentation nor any direct products thereof is 
being or will be downloaded, shipped, transferred, exported, or re-exported, directly or indirectly, into any country to which export is prohibited 
by the laws and regulations of the United States. 
 
5. Government End Users. If acquiring the Software on behalf of any unit or agent of the United States government, the Customer agrees that: 
(a) the Software is "Commercial Computer Software" as the term is defined in paragraph 27.401 of the DoD Supplement to the Federal 
Acquisition Regulations (the "Supplement") or is within the equivalent classification of any other federal agencies' regulations; (b) the Software 
was developed at private expense, and no part of it was developed with government funds: (c) the government's use of the Software is subject to 
"Restricted Rights" as that term is defined in clause 52.227-7013 (b) (3) (ii) of the supplement or in the equivalent clause of any other federal 
agencies' regulations; (d) the Software is a "trade secret' of the licensor for all purposes of the Freedom of Information Act; and (e) each copy of 
the Software will contain the Following Restricted Rights Legend: 

"Restricted Rights Legend" 
Use, duplication, or disclosure is subject to restriction as set forth in the subdivision (b) (3) (ii) of the Rights in the Technical Data and Computer 
Software clause at FAR 52.227-7013. Manufacturer: Doremi Labs, Inc., 306 E. Alameda Ave., Burbank, CA 91502. 
The Customer agrees to indemnify Licensor for any liability, loss, costs and expense (including court cost and reasonable attorney's fees) arising 
out of any breach of the provisions of this Agreement relating to use by the government. 
 
6. Terms. The license is effective until terminated. Customers may terminate it at any time by destroying the Software together with all copies. 
The license will also terminate upon conditions set forth elsewhere in this Agreement. The Customer agrees upon such termination to destroy all 
copies of the Software. 
 
7. Disclaimer of Warranty. 
THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, WITH RESPECT 
TO ITS MERCHANDABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND 
PERFORMANCE OF THE SOFTWARE IS WITH THE CUSTOMER. SHOULD THE SOFTWARE PROVE DEFECTIVE, THE CUSTOMER 
(AND NOT LICENSOR OR A LICENSOR AUTHORIZED DISTRIBUTOR) ASSUMES THE ENTIRE COST OF ALL NECESSARY 
SERVICING, REPAIRING, OR CORRECTION. 
LICENSOR DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE 
CUSTOMER'S REQUIREMENT OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE OR 
THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. IF ANY MODEL OR SAMPLE WAS SHOWN TO THE CUSTOMER, 
SUCH A MODEL OR SAMPLE WAS USED MERELY TO ILLUSTRATE THE GENERAL TYPE AND QUALITY OF THE SOFTWARE 
AND NOT TO REPRESENT THAT THE SOFTWARE WOULD NECESSARILY CONFORM TO SUCH A MODEL OR SAMPLE. 
Some states do not allow the exclusion of implied warranties, so the above exclusion may not apply to the Customer. 
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8. Limitation of Remedies. The Licensor shall not, under any circumstances, be liable to the Customers for any indirect, 
consequential or incidental damages arising out of the use, or results of use of, the software and documentation or otherwise relating to the 
functioning thereof or arising out of any breach of this agreement by the Licensor, even if the licensor has been advised of the possibility of such 
damages. Licensor's liability to the Customer for actual damages for any cause whatsoever, and regardless of the form of the action, will be 
limited to the greater of $300 or the money paid for the Software that caused the damages or that is the subject matter of, or is directly related to, 
the cause of action. 
Some states do not allow the limitation or exclusion of liability for incidental or consequential damages so the above limitation or exclusion may 
not apply to customer. 
 
9. General. 
(a) The terms of this Agreement are intended as a final expression of the parties' agreement with respect to such terms as are included in this 
Agreement and may not be contradicted by evidence of any prior or contemporaneous agreement. This Agreement constitutes the complete and 
exclusive statement of its terms and no extrinsic evidence whatsoever may be introduced in any judicial proceeding, if any, involving this 
Agreement. 
(b) This Agreement shall be construed and enforced in accordance with the laws of the State of California applicable to contracts made and to be 
performed entirely in the State of California. 
(c) If any portion of any provision of this Agreement is ruled invalid or unenforceable under any applicable law, that provision will be enforced to 
the maximum extent permissible, and the remainder of this Agreement shall continue in full force and effect. 
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WARNING  
 

THIS APPARATUS MUST BE EARTHED 
 

IMPORTANT 
 

WARNING 
 
Power requirements for electrical equipment vary from area to area. Please ensure that your ORCA meets the power 
requirements in your area. If in doubt, consult a qualified electrician or your Doremi Labs dealer. 
 ORCA Capture Station 

@60Hz for USA and CANADA rating 400W 4A 110V   
@50Hz for Europe rating 400W 2A 220V 
ORCA  
@60Hz for USA and CANADA rating 100W 1A 110V   
@50Hz for Europe rating 100W .5A 220V 

 
AVIS  

 
Le voltage peut differer d’un pays a l’autre. Il faut que le ORCA soit ajuste au voltage du pays. 
LA SOURCE DE PUISSANCE DOIT AVOIR UN CONDUCTEUR CONNECTE A LA TERRE.Toutes 
reparations doient etre effectuees par une personne qualifiee.AFIN D’EVITER UN CHOC ELECTRIQUE, 
VEUILLEZ NE PAS ENLEVER LE CAPOT. 
 

PROTECTING YOURSELF AND THE ORCA 
 
Never touch the AC plug with wet hands 
Always disconnect the ORCA from the power supply by pulling on the plug, not the cord.  
Allow only a Doremi Labs, Inc. dealer or qualified professional engineer to repair or reassemble the ORCA. Apart 
from voiding the warranty, unauthorized engineers might touch live internal parts and receive a serious electric 
shock.  
Do not put, or allow anyone to put any object, especially metal objects into the ORCA. Use only an AC power 
supply.  
Never use a DC power supply.  
If water or any other liquid is spilled into or onto the ORCA, disconnect the power, and call your dealer.  
Make sure the unit is well ventilated, and away from direct sunlight. To avoid damage to internal circuitry, as well 
as the external finish, keep the ORCA away from sources of direct heat (stoves, radiators, etc.).  
Avoid using aerosol insecticides, etc. near the ORCA. They may damage the surface, and may ignite. Do not use 
denatured alcohol, thinner or similar chemicals to clean the ORCA. They will damage the finish.  
Modification of this equipment is dangerous, and can result in the functions of the ORCA being impaired. Never 
attempt to modify the equipment in any way.  
In order to ensure optimum performance of your ORCA, select the setup location carefully, and make sure the 
equipment is used properly. Avoid setting up the ORCA in the following locations:  

1. In a humid or dusty environment 
2. In a room with poor ventilation 
3. On a surface which is not horizontal 
4. Inside a vehicle such as a car, where it will be subject to vibration 
5. In an extremely hot or cold environment 
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CAUTION

RISK OF ELECTRIC SHOCK
DO NOT OPEN

    
!

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK,
DO NOT REMOVE COVER (OR BACK).

NO USER-SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The lightning flash with the arrowhead symbol superimposed
across a graphical representation of a person, within an equilateral
triangle, is intended to alert the user to the presence of uninsulated
“dangerous voltage” within the product’s enclosure; that may be
of sufficient magnitude to constitute a risk of electric shock.

!
The exclamation point within an equilateral triangle is intended to
alert the user to the presence of important operating and
maintenance (servicing) instructions in the literature
accompanying the appliance.

WARNING!!

To prevent fire or shock hazard, do not expose this appliance to rain or moisture
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CE NOTICE  
  

 

Marking by the symbol  indicates compliance of the device to the EMC (Electromagnetic 
Compatibility) directive and to the Low Voltage directive of the European Community. Such 

marking is indicative that this device meets or exceeds the following technical standard: 

 

• EN 55022 "Limits and Methods of Measurement of Radio Interface Characteristics of 
Information Technology Equipment." 

 

A "Declaration of Conformity" in accordance with the above standard has been made and is on 
file at Doremi Labs, Europe, Valbonne, France. 
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1 INTRODUCTION 
 
 
Thank you for your ORCA purchase. ORCA is a high quality HD and SD MPEG2 video encoder that encodes 
MPEG2 files up to 160mbs. It provides users with a wide choice of encoding parameters such as GOP structure, 
4:2:0 and 4:2:2 encoding profiles and compression bit rate. These parameters provide the user with precise control 
of the encoding process and, consequently, the flexibility to encode content for a variety of applications. 
 
ORCA encodes standard definition up to 50Mbits/sec and HD files up to 160Mbits/sec. ORCA comes in two 
different packages and has many options that can be added at a later time. 
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2 ORCA Packages 
 
The ORCA MPEG2 encoder comes in two packages, as a standalone 1RU chassis and as a complete capture station. 
 

2.1 ORCA-SD, ORCA-420, ORCA-422 and ORCA-422-Pro 

 
ORCA-SD can encode all SD formats up to 80Mbits/sec in 422 or 420 
ORCA-420 can encode all SD and HD formats in 420 up to 80Mbits/sec 
ORCA-422 can encode all SD and HD formats in 422 or 420 up to 80Mbits/sec 
ORCA-422-Pro can encode all SD and HD formats in 422 or 420 up to 160Mbits/sec 
 
In this manual these units will be referred to as “standalone ORCA”. 
 
These ORCA models are provided in a 1RU chassis with the following connections on the back panel: 
 
HD-SDI input: Connect to your video source 
AES/EBU input: Connect to AES/EBU audio of the video source 
ASI output: Connect to an ASI decoder such as Doremi Labs’ Nugget-Decoder 
Ethernet output: Connect to a PC running ORCA Control Panel via crossover cable or Ethernet Switch 
RS422-1: For debug purposes (for Doremi technical use only) 
RS422-2: Master P2 controller port for machine control 
AC Power with a rear panel power switch 
 
 
 
 
 
 

RS-422-2 RS-422-1

DVB/ASI
OUT

HD/SD SDI
IN ETHERNET

AES/EBU
IN

 
 
 
 



 11

2.2 ORCA-CS, ORCA-CS-Pro 

 
ORCA-CS can encode all SD and HD formats up to 80Mbits/sec in 422 or 420 
ORCA-CS-Pro can encode all SD and HD formats in 422 or 420 up to 160Mbits/sec 
 
In this manual these units will be referred to as “ORCA Capture Station” or “ORCA CS”. 
 
ORCA-CS is a complete MPEG2 capture station that includes a decoder. The system is Linux based and has 2 major 
components; the Capture Station (3RU) and the Decoder (1RU). 
 
Back panel connections include: 
 
Standard computer connections: such as VGA, USB Keyboard and USB Mouse (not included) 
Gigabit Ethernet: Connect to your LAN 
HD-SDI input: Connect to your video source 
AES/EBU input: Connect to AES/EBU of the video source 
ORCA-ASI output: Connect to ASI card Receive BNC 
ASI card Transmit: 2 available connect any of them to the Nugget-Dec ASI input. 
ORCA-100BT: Connect to Netgear’s 100BT using the provided Ethernet crossover cable 
RS422: Connect to V1-UHD, V1-HD, HDCAM, D5, DVCPro, etc. 
 

RS422

AES-IN

ASI-OUT

HDSDI-IN

GIGABIT

ASI
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2.3 Available Options 
ORCA-SD 

• EDL: Allows encoding with machine control based on an EDL 
 
ORCA-420: 

• 422/420: adds 422 capabilities 
• Pro: Adds 422 and bitrates up to 160 Mbits/sec 
• EDL: Allows encoding with machine control based on an EDL 

 
ORCA-422: 

• Pro: Adds bitrates up to 160 Mbits/sec 
• EDL: Allows encoding with machine control based on an EDL 

 

2.4 Standalone ORCA vs. ORCA Capture Station 
 
The standalone ORCA does not include a decoder and can only capture files to disk using the Ethernet port, which is 
limited to 60 Mbits/sec. 
 
The ORCA capture station includes a decoder and it allows recording to disk up to 160Mbits/sec. During recording 
the decoder shows the encoded then decoded signal for instant verification. It can also play files and display them on 
an HD-SDI video monitor. 
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3 ORCA IP Address 
 
All ORCA units are shipped with a default IP address of 192.168.100.181 
 
You must change the IP address on your Windows PC to be in the same subnet mask of the ORCA to be able to 
connect to it. A good setup for your PC would be: 
IP: 192.168.100.100 
Subnet Mask: 255.255.255.0 
 
Run the ORCA Control Panel and make a connection to the ORCA by typing its IP address. If the connection is 
made, the timecode window at the bottom of the window will show 00:00:00:00. If the connection is not made, the 
timecode window will display 01:02:03:04 
 
To change the IP address select Config>Change IP 
 
 

 
 
Type the new IP and subnet mask and hit OK 
A pop up window will ask you to reboot the ORCA to set the new IP address, hit OK to reboot and start with a new 
IP address. 
 
You will need to restart the ORCA control panel and connect using the new IP address. 
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4 Encoding 
 
Before encoding, you need to check the five tabs labeled: Sources, Output, Compression, Advanced and External to 
ensure that all parameters are set properly.  
 
The bottom line of the ORCA Control Panel, shown below, does not change and it allows you to start encoding from 
within any tab. 
 

 
 
Every time you change a parameter on the ORCA, the Encode button will be grayed out until you press Apply.  
Selecting Revert will revert the configuration to the last one saved.  
Press Encode to start encoding, the encoding will not stop until you hit Stop, the input signal disappears or changes, 
or when the file size limit is reached. 
 
Pause will pause the encoding but keep the file open to continue recording. Pause is only available on units with the 
EDL option. 
 
ORCA has 2 main outputs: ASI and Ethernet 
 

4.1 Ethernet output 
 
ORCA can capture files up to 60 Mbits/sec directly on the Ethernet connection. To get this bitrate, use a crossover 
cable or use an Ethernet switch on a small network. You can monitor the report tab during or after encoding to make 
sure no frames were dropped. The file transfer uses the TCP/IP protocol 
 

4.2 ASI output 
 
On the ASI output, ORCA can encode up to 160Mbits/sec.  
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5 ORCA Menus 
 
FILE 

• File>New.., not used 
• File>Open.., open a previously saved configuration file 
• File>Save, save a configuration file 
• File>Save as.., save the current configuration to a file 

CONFIG 
• Config>Change IP, pops up a window to change the IP address 
• Config >Reboot, reboots the ORCA unit, quit and connect again in about a minute 
• Config>Save Encoding Parameters, save current configuration to the ORCA internal memory 
• Config>Load Encoding Parameters, Load the configuration saved on the ORCA internal memory 
• Config>Upgrade Firmware, upgrade the ORCA firmware using this menu. ALL NECESSARY FILES 

FOR THE NEW VERSION MUST BE DOWNLOADED TO THE ORCA BEFORE YOU REBOOT IT. 
• Config>Licensing, use to add options to your ORCA. You can contact sales@doremilabs.com to purchase 

the available options 
E.D.L 

• EDL>New, creates a new EDL 
• EDL>Open, open an existing EDL 
• EDL>Save, save an open EDL 
• EDL>Save as, save an EDL on the PC 
• EDL>Edit, edit the open EDL 
• EDL>Close, close the open EDL 

ABOUT 
• About>About ORCA, shows the current firmware version and release date, Control panel version (GUI) 

and installed options 
 

mailto:sales@doremilabs.com
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6 ORCA Tabs 
 

6.1 Sources 
 
 

 
 
 
Use this tab to select the video source, audio source and various PIDs for the transport stream. 
 
The only source available for video is SDI. 
Available sources for audio are: Embedded SDI or AES/EBU.  
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When Embedded SDI is selected, the configure button will become active to allow audio channel configuration. 
 

 
 
The PID section of the audio configuration window will only show when uncompressed audio is selected from the 
Compression tab. 
 
Current Input Video Format will show the input format in black or No Video Detected in red to indicate no input or 
un-supported input format. 
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6.2 Output 
 

 
 
 
Select ASI or Ethernet as the output format. 
 
When you select ASI, the Save to file tab will be grayed out on a Standalone ORCA, but it will be active on an 
ORCA Capture Station, where you can browse for the /data directory and type a filename to encode to. Use the .ts 
extension known for transport stream files. 
 
When you select Ethernet, the Save to file can be used to browse for a directory to store the transport stream files. If 
you are running the ORCA Control Panel on a Linux system, we recommend that you create a /data directory and 
put all transport stream files in it. It’s a preference not a rule. 
 
Check the File size tab to limit the file size. 
 
The Playback from ASI Capture Card will only be active on an ORCA capture station. It allows loading a transport 
stream file and playing it on the ASI output for decoding using the ORCA capture station decoder, otherwise know 
as the Nugget-Dec decoder. Clicking the EE button will put the ASI card in passthrough mode. 
 



 19

6.3 Compression 
 
Set all compression parameters for video and audio. 
 
 

 
 
 
Video: Select CBR or VBR 
VideoBitRate: Displayed in bits per seconds 
VBV Buffer size: The control panel will suggest a VBV size each time you change the bitrate 
Intra DC precision: Use higher numbers for better encoding quality but make sure the decoders you use support 
higher precisions. All decoders support 8bit and that is the default on the ORCA. 
 
GOP Size: Specify the GOP size, most standardized GOP sizes are 15 and 1 
M: Specifies the number of Bs in the GOP sequence. Most standardized M sizes are 2 (GOP=15) and 0 (I-Only) 
Audio: Select Uncompressed, MPEG1-Layer II or externally compressed. Use externally compressed if the audio 
input selected is already encoded by another device. Use MPEG1-Layer II to compress the audio input selected. 
 
When MPEG-1 Layer II audio is selected, you can specify the audio bitrate: 192, 256 and 384 Kbits/sec 
When externally compressed is used, you can specify a delay in frames to compensate for the audio encoder’s delay 
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6.4 Advanced 
 
Use to set transport stream information for broadcast applications, Timecode selection and PCR/PAT/PMT 
frequency configuration. 
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When Static PSIP is selected, the Configure PSIP window will become active  
 

 
 
 
Enter the channel short name; major and minor channel numbers and carrier frequency 
 
Selecting the PCR/PAT/PMT Configure button will pop up the window below: 
 

 
 
This defines the repetition clock for PCR/PAT/PMT. It can be defined in milliseconds, microseconds or based on a 
27Mhz clock. Shown in the picture above are the most standard values. 
 
Check the Timecode box if you want to either preserve the original timecode or start with a new timecode defined 
by the Start time. 
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6.5 External 
 
Using this tab you can control an external device to create a file that starts and ends at specific timecode locations. 
Check the External device control box to enable.  

• If External device control is shown in red, it indicates that the application cannot communicate with the 
external device using P2 protocol. Make sure that you have a proper connection between RS422-2 and the 
machine on the standalone ORCA or between RS422 and the machine on the ORCA capture station. Earlier 
standalone ORCA units were shipped with RS422-2 set as a slave port, a special adaptor should be 
connected to the RS422-2 port to make it a Master P2 port. 
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• If External device control is shown in green, it indicates a good connection. 
 
Available commands are: 
 

• Locate: type the timecode location and hit locate to cue the machine 
• LTC: Reflects the Time Mode of the machine when you make the connection, you can change it to force 

the machine to use Control Track, LTC or VITC. 
• Transport Sontrols: (from left to right) Step Backwards, Rewind, Pause, Play, Fast Forward and Step 

Forward 
 
Use the Time in and Time out windows to either capture the current location or manually type the in and out points 
for you file. 
 
If your unit has the EDL option, you can check the Use EDL box to use the open EDL. 
 

6.6 Filters 
 
The Filters tab is reserved for future use 
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6.7 Reports 
 
Displays reports and statistics during encoding 
 

 
 
 
Most of the information provided by this tab is for Doremi technical use only. The most useful parameter for client’s 
use is the “Frame Dropped”. Watch this parameter as you encode through Ethernet to make sure the file generated 
does not have any dropped frames. If you get dropped frames at lower than 60Mbits/sec, you need to check your 
Ethernet connection. 
 
 



 24

7 EDL 
 
The EDL options allow the ORCA to encode one or many files automatically based on an edit decision list or EDL. 
The information contained in the EDL tells the unit which tape to use and the IN and OUT point of every edit. You 
can invoke the EDL by selecting EDL>New 
 

 
 
Click Add to add a new entry to the EDL 
Click Edit to edit the selected entry 
Click Delete to delete the selected entry 
Click Single file to have the unit generate a single file instead of individual files per edit. 
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The edit window: 
 

 
 
Clip Number: Clip number in the EDL 
Link Enable: Must be checked to enable execution of the edit. 
Clip Name: Name assigned to the edit 
Tape Name: If you want to alert the user to change tapes, the ORCA will stop every time the tape name changes. 
Time IN and Time OUT 
File Name: The transport stream file to create 
Profile: the configuration file to use for the edit 
 
If Single file is selected, the configuration file will be the one specified for the first edit. If non exist on the first edit, 
the ORCA will use the current configuration. 
 
During EDL entry and before encoding, the ORCA does a sanity check on the EDL and signals warning and errors 
by adding colored icons on the EDL Window. Remove all errors before executing the EDL. 
 
To use the EDL, make sure you select Use EDL on the External tab before you hit Encode. 
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8 ORCA Capture Station 
 
The ORCA capture station is based on Redhat Linux 9 (kernel 2.4). It has a single internal drive, 400GB or smaller 
depending on the largest drive available at shipping time. All recording, configuration files and EDLs should be 
placed in the /data directory. On earlier installations, the /data used to refer to a RAID-0 setup with 2 additional 
drives. 
 

8.1 Login information 
 
The root password is veeone 
 
Another user called ORCA is usually created, the password for ORCA is doremi. 
 

8.2 Fiber Channel Connection 
 
Newer ORCA Capture Stations are shipped with motherboards with at least one PCI-X slot. Clients can add their 
own Fiber Channel card and drivers. Doremi is not responsible for installing the FC card and making it work on the 
ORCA-CS. 
 

8.3 Running the ORCA Control Panel software 
 
The ORCA application should reside in a bin folder. The location of the bin folder is: 
 
For user root: /root/bin 
For user ORCA: /home/ORCA/bin 
 
If you create a new user, you must copy the /bin from /root/bin to /home/username/bin where username is the new 
user name. 
 

8.4  Network Configuration (IP addresses) 
 
The Gigabit (eth0) is configured to get the IP from DHCP 
The 100BT (eth1) is configured with a static IP address of 192.168.100.151 
As mentioned previously the ORCA is configured with an IP address of 192.169.100.181 
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